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STR71x Software Development - Getting Star ted 
 
 
 
Introduction 
 
This document provides an introduction to the STR71x Evaluation board describing how to set up 
the board and the software environment required to develop an STR71x application from scratch. It 
summarises the different steps needed to configure the development toolchain and how to use the 
template software library to build and to debug a sample STR71x application on the target 
hardware.  
 
It covers the following: 
 
 

·  Board layout 
·  Connecting the board 
·  Power supply configuration 
·  Boot configuration 
·  LCD/LED/CON2 configuration 
·  JTAG connection 
·  Installing software 
·  Launch Idealist 
·  Open one of the examples 
·  Project settings 
·  Building the project 
·  Open the debugger and download the code 
·  Run the program 
·  Stop the program 
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Board layout 
 
 
 

 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 1: Board layout 
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Connecting the board 
 

 
Figure 2: Host to board connections 

 
 
Power supply configuration 

 
The board requires a 9V DC 0.5A power supply with a 2.1mm DC plug, centre pin positive. 
This supplies a 5V DC regulator for the LCD and CAN bus alongside a dual output regulator 
supplying 3.3V DC and 1.8V DC for the micro-controller and other peripherals. The 5V and 
3.3V rails are also connected to pins 1 and 3, and pin 2 of CON2 respectively for off board 
prototyping. 
 
The 3.3V and 1.8V rails are jumper selectable alongside a 1.8VBKP supply to the micro-
controller that enables operation with or without use of the on-chip 1.8V regulator and to aid 
development of low power operation modes. 
 
 
 

Link Voltage 

LK15 3.3V 

LK16 1.8V 

LK17 1.8VBKP 
 

Table 1: Power supply configuration 
 

 
The default condition is with all three links made, i.e. all supplies available to the board. 
 

Dev Board 

Power supply 

PC 

JTAG interface 

CAN or USB 
RS232 
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Boot configuration 

 
Four different boot modes are available which can be enabled by means of the three input pins, 
BOOTEN, BOOT1 and BOOT0. 
 
 

BOOTEN BOOT1 BOOT0 

LK18 LK19 LK20 
MODE 

0 X X 

1 0 0 
USER: boot from internal FLASH memory 

1 0 1 System Memory Boot 

1 1 0 RAM: boot from internal RAM 

1 1 1 EXTMEM: boot from external memory 

 
Table 2: Boot management 

 
The default condition is 100, i.e. USER: boot from internal FLASH memory 

 
 

LCD/LED/CON2 configuration 
 
There are 14 configurable I/O’s available on the board, LK1 to LK14. All 14 are permanently 
connected to CON2 and all can be connected to a LED. The LCD requires 12 I/O’s in 8-bit mode 
(LK1 to LK12) with SW1 and SW2 using LK13 and LK14. 
 
 

Link I/O left off right 
LK1 P1.9 LCD CON2 LED 
LK2 P1.8 LCD CON2 LED 

LK3 P1.7 LCD CON2 LED 

LK4 P1.6 LCD CON2 LED 

LK5 P1.5 LCD CON2 LED 

LK6 P1.4 LCD CON2 LED 

LK7 P1.3 LCD CON2 LED 

LK8 P1.2 LCD CON2 LED 

LK9 P0.12 LCD CON2 LED 

LK10 P0.13 LCD CON2 LED 

LK11 P0.14 LCD CON2 LED 

LK12 P0.0 LCD CON2 LED 

LK13 P0.1 SW1 CON2 LED 

LK14 P1.14 SW2 CON2 LED 

 
Table 3: I/O configuration 
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The default condition is for the LCD to be in 8-bit mode (LK1 to LK12 in left hand position) and 2 
LED’s to be selected (LK13 and LK14 in right hand position). 
JTAG connection 
 
The JTAG interface is designed into the main board but as an independent circuit that can be 
broken off if required. A 20-way IDC cable links the main board and the JTAG board via two 20-
way box headers, CON9 and CON11. A 25-way parallel cable connects the JTAG board to the host 
PC. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3: Connecting to the host PC 
 
Installing software 
 
IDEaliST is the free debug software supplied with the STR7 development board along with the 
STR7 toolchain, ‘sarm.exe’ . Install both applications on the host PC. 
 
The Anglia IDEaliST is a 32Bit integrated Development Environment for ST’s range of 
microcontrollers. It is a graphical front-end to the build tools available from ST to write and build 
code for their range of microcontrollers without having to use a command line. It offers support for 
the range of ST6, uPSD and STR7 ARM7 microcontrollers. 
 
The IDE is simple and easy to use with all the necessary tools available without having to leave the 
IDE. Wizards are available to help you create and edit projects so keeping track of your code is 
easy. It features a fully integrated syntax editor to make writing code easier.

20-way 
IDC cable 

JTAG board 

Main board 

To PC 
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Launch IDEaliST 
 
Once the board has power and is connected to the host PC launch IDEaliST. 
 

 
 

Figure 4: Launch IDEaliST 

 
 
Open one of the examples. 
 

 

 
 
 

Figure 5: Open an example – File>Open Project>lcddemo>lcddemo.stw 
 
 
The default file type is ‘ .stw’  (Idealist project file extension) and by opening this file all relevant 
project files are loaded into the workspace. Folders for Source, Include and Dependencies can now 
be viewed in the left hand column and can be opened to show the appropriate code.  
 
There are several examples for both versions of the board along with the relevant application notes 
from ST in pdf format. All Files (* .* ) needs to be selected from the Files of type: drop down 
window. 
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Below is a brief summary of what examples are available. 
 
AN1782 How to use the STR71x I2C peripheral to communicate with an I2C Protocol-

Compatible Electrically Erasable Programmable Read Only Memory (EEPROM). 
The application note uses the M24C08 which is a member of the M24CXX 
EEPROM family. The software implemented manages Write and Read Modes in 
communication between the STR71x I2C interface and the M24C08. 

 
AN1797 How to create a standard communications interface between a STR71x 

microcontroller and a PC. This communication is done through the STR71x UART 
peripheral and a serial port of the PC using the RS 232 protocol. 

 
AN1798 How to reduce the conversion time of the A/D Converter of the STR71x 

microcontroller, when only one input needs to be converted. To do this we use 
Round Robin mode instead of Single Channel mode to convert an analog input 
signal which must be connected to all four analog input pins of the converter. 

 
AN1810 This shows an easy way of communicating between a STR71 microcontroller and a 

M25P10-A SPI Serial Flash memory. The purpose is to perform, through BSPI, a 
write in the memory, followed by a read of the written data. 

 
EvalStr71/2/3 ST source code for ST STR710, STR720 and STR730 Eval Boards libraries. 
 
Hello  A simple ‘hello world’  compiler demo. 
 
Hellocpp The same as above but in C++. 
 
Lcddemo This is an example program that demonstrates the use of the LCD and will display  

‘ *  Anglia STR7 *    **  Demo Board ** ’  and flash LED 14 about 3 times a second. 
 
Libstr71/2/3x Source code for the STR710/710/730 software library. 
 
Scripts  These are linker and debugger scripts to put in new projects. 
 
Usb71/2x This is an example program that demonstrates the use of the USB version of the 

board. 
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Project settings. 
 

Setup: Compiler options, in particular, the STR7 device, include and object directories.  
 Linker options, in particular, the linker script and user libraries. 
 Build settings, in particular, the debugger script, parallel and GDB port. 
 

 
 
 

 
 
 

 
 

Figure 6: Setup Project Settings – Options>Project Settings 
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Building the project. 
 
Project folders in the left hand ‘Workspace’  window can be added to by right clicking on them and 
browsing to your file. These files can be viewed in the main window by double clicking on them. 
Help files included in the package can be selected in the same window by clicking on the Help tab. 
 
 

 
 

Figure 7: Build the project – Build>Build 
 
The ‘Output’  window along the bottom of the page displays the progress of the compiler and any 
errors. 
Before debugging, check that the Build Settings/Debug Options are configured to match your target 
hardware. Check a GDB script has been selected - this is used to setup target settings for the debug 
session. This is a text file which GDB will read at start-up. More information can be found in the 
debug manual. Insight GDB will also need configuring to the same settings as here, i.e. GDB port 
needs to match. The script can also be used to setup external memory interfaces, for an example 
look in target.ini in the project folder. 
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Figure 7: Setup Target Properties – File>Target Settings 
 
Open the debugger and download the code. 
 
 
 

 
 

Figure 8: Open the Debugger – Plug-in>Run Insight Debugger 
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Run the program. 
 

 
 

Figure 9: Run the program – Control>Continue 
 
 
The LCD should display;  *  Anglia STR7 *  
                * *  Demo Board **  
 
LED14 will turn ‘ON’  and ‘OFF’  approximately twice a second. 
 
Stop the program. 
 
 

 
 

Figure 10: Stop the program –STOP 
 
 

LED14 will stop flashing. It will be ‘ON’  or ‘OFF’  depending on where the program stops. 
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Flash Programming/Debugging 
 
RAM is often used during the development stage of an application, but at some point the 
application will need to execute from Flash. Certain limitations apply when debugging a program 
in Flash. Due to the limitations of the ARM7 core only 2 Hardware breakpoints/watchpoints are 
available. In contrast unlimited breakpoints/watchpoints are available when debugging a RAM 
based application. 
 
Before the program can be programmed to Flash memory the linker script will need changing to 
suit the different memory layout.  
The easiest way is to create another project configuration, eg. Release with the rom.ld linker script. 
rom.ld is a default flash based linker script – this may need modifying to suit your target 
application. 
You will also need to select Create Other Format and choose s19 – the Flash programmer will use 
this file. 
 
The next stage is to program the device with the code – select Plugin/Program Flash from the top 
menu. 
Choose the s19 file created in the step above and press Program. 
 
Next choose Plugin/Run Insight Debugger to start Insight, the target settings will need modifying 
for a Flash based target - see below. 
 
 

 
 

Figure 11: Flash Debugging Settings  
 

This differs from RAM targets in that the Download Program and Set Breakpoint at main will need 
unchecking. 
 
Note: 
Software breakpoints are not possible while debugging in Flash – a possible solution is given 
below. 
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To correctly reset and stop the target some commands have been defined. 
These commands are defined in the file target.ini in your project directory. A sample target.ini file 
can also be found in the scripts directory. 
 
ramreset – reset target, remap internal RAM to address 0x00. 
flashreset – reset target, remap internal Flash to address 0x00 and set temp hardware breakpoint at 
main function. 
emireset – reset target, remap emi to address 0x00. 
reset – reset target. 
 
Press OK to close the Target Selection Dialog. 
As with RAM Debugging Press Run to start the debugging session. If the resetmain command was 
entered as above then the device will stop at the function main. 
 
Hardware Breakpoints 
 
To enable the debugger to use hardware breakpoints it must be informed, this is done using the 
following command in the console window. 
monitor softbkpts off 
This command would normally be done as part of the flashreset script described above. 
 
For further details on all commands refer to the Debug Reference included in the Toolchain. 
 
Program Stepping 
 
To enable program stepping Flash breakpoints are used, because of this only one hardware 
breakpoint can be set when stepping through code. 
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RAM Functions 
 
Sometimes it is advantageous to run parts of your code from RAM, while the main code is stored in 
Flash. The reasons for this can be due to faster execution in RAM for debugging. 
The standard linker scripts contain a special section for this called fastrun used for this purpose. 
See the example ramfunc in the examples dir. 
 
C L ibrary Notes 
 
Included with the Anglia SARM toolchain is a c library, the library used is newlib which has been 
configured to better suit a small embedded target. 
 
Certain precautions need to be observed to obtain minimum code density. 
With newlib stdio functions there are two versions available, one built with float support and 
another with just integer support. For example. 
 

C Library Function Integer Support 
printf iprintf 
sprintf siprintf 
scanf iscanf 
sscanf siscanf 
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5 Revision history 
 
 
 

Version Date Comments 

1.2 Nov 2005 Updated Flash Debugging Information 

1.1 July 2005 Updated Flash Debugging Information 

1.0 Feb 2005 First complete revision for AD5002-Issue1_31 board and Software revision 1.35 
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